Form and Style Guide

Prepared for

Teacher Education Department Students

Warner University

Lake Wales, FL

2012
# Table of Contents

Introduction.............................................................................................................................................. 1

Formatting Requirements............................................................................................................................ 1
  Formatted Templates ................................................................................................................................. 1
  APA ........................................................................................................................................................... 1
  Font .......................................................................................................................................................... 2
  Indenting .................................................................................................................................................. 3
  Text Alignment ........................................................................................................................................ 3
  Line Spacing .......................................................................................................................................... 3
  Page Numbering ...................................................................................................................................... 3
  Margins .................................................................................................................................................... 4
  Borders and Graphics ............................................................................................................................... 4
  Paragraphs ............................................................................................................................................... 5
  Headings and Subheadings ....................................................................................................................... 5

Sample Title Page ..................................................................................................................................... 7

Sample Template for Written Papers ......................................................................................................... 9

Sample Reference Page ............................................................................................................................. 11

APA Help Sheet ......................................................................................................................................... 13

DOI and URL Flowchart ............................................................................................................................. 19
Introduction

College level writing is challenging for many students. The new requirements for content, clarity, formatting, and style often leave students confused as to what is expected in each class. The faculty at Warner University understands these concerns and has established a set of requirements for all written assignments.

Not all assignments require “formal” papers. You may create a “publication,” poster, or some other type of project that does not require you to write a paper. Your professor will provide you with specific guidelines for these projects in class and in the individual course syllabi. In addition, professors may choose to alter some of the format and style requirements as deemed appropriate for the content or purpose of specific assignments. Please pay careful attention to their instructions and assignment directions!

Formatting Requirements

Formatted Templates

Several professors have created formatted templates for specific assignments. Whenever these templates are provided, you are strongly encouraged to use them in their original format rather than trying to recreate the format on your own. An example of a formatted template will be provided in this style guide.

APA

The use of APA Edition 6 is required for all references and citations. An APA Help Sheet is provided in this style guide for you to use as a quick reference guide and contains many of the most commonly used forms of citations and references. Please refer to the APA Publications Manual, 6th Edition for additional information. Please remember: MLA or other forms of citation and reference formatting are not permitted in the Teacher Education Department.

Paraphrasing and quoting. Whenever possible, you should paraphrase what you read
into your own words. This demonstrates your understanding of what you are reading as well as your ability to synthesize information. However, when it is necessary to use a direct quote, be sure to follow the guidelines above. If you find it necessary to use a lengthy direct quote, follow this rule:

A direct quote that exceeds 40 words is to be placed in a block format. This means the entire quote is indented ½ inch and no quotation marks are used. If the direct quote does not meet the 40 word limit, you should use quotation marks before and after the quote. You can determine the length of a direct quote by following these steps:

1. Highlight the quote with your cursor.
2. Click on the “Review” tab and the word count will appear.

APA “Golden Rule”. If a source is cited anywhere in the paper, it must be included in the references AND if a source is listed in the references, it must first be cited in the paper. There are no exceptions to this Golden Rule!

APA “warning”. It is tempting to use the citation generators found in Microsoft Word. While they do work sometimes for certain types of references and citations, there are nearly always errors in formatting. It takes you just as long to enter the information into the citation generator as it does to manually format the references. If you use this help sheet and the APA Manual, you will quickly learn how to format your references and citations correctly. Remember, if you have a question about a reference or citation, just ask your professor.

Font

Use size 12 Times New Roman font for all papers. This includes the title page, headings, subheadings, references, and any other pages in the document. Use only black color unless specifically instructed to do otherwise.
Indenting

All paragraphs are to be indented a full ½ inch. In order to make sure this requirement is met, follow these steps:

1. Right click on the first page of your paper.
2. Select “Paragraph”.
3. Find “Indentation” and select “First Line” from the drop down menu.
4. Enter 0.5 into the box.
5. Click OK.

In addition, numbered and bulleted lists should also align with the ½ inch indent requirement with the number or bullet being indented ½ inch following by the text of the information.

Text Alignment

Use only left margin alignment for all writing.

Line Spacing

Use only double line spacing throughout your paper. To be sure this is done correctly, follow these steps:

1. Right click on the first page of your paper.
2. Select “Paragraph”.
3. Locate the “Spacing” options and set both “Before” and “After” to “0”.
4. Select “Double” from the “Line spacing” option.
5. Click OK.

Page Numbering

Page numbers should be placed in the upper right corner of the HEADER row. In order to insert page numbers, follow these steps:

1. Click on the “Insert” tab.
2. Select “Page Numbers”.

3. Select “Top of Page”.

4. Select “Plain Number 3”.

The page numbers must be the same font size and style as the paper so once you insert the page number, highlight it and reset the font to size 12 Times New Roman.

**Margins**

Margins provide a frame for your paper. The margins for all papers should be 1 inch on the top, bottom, and both sides. In order to make sure the margins are correct, follow these steps:

1. Click on the “Page Layout” tab.

2. Select “Margins”.

3. Select “Custom Margins” and the “Page Layout” box will open.

4. Set the top, left, and right margins to 1” but set the bottom margin to 0.88”.

5. Click OK.

6. Next, right click and once again select “Paragraph”.

7. Click on the “Line and Page Breaks” tab.

8. UN-check all four boxes under “Pagination”.

9. Click OK.

**Borders and Graphics**

The use of borders or graphics is generally not permitted. This does not apply to graphs, figures, or other appropriate data that provides supporting information and strengthens your paper. Your course instructor may recommend the use of borders and graphics for specific assignments such as parent information or newsletters or other “publications.” Be sure to request permission before inserting borders or graphics anywhere in your paper.
Paragraphs

College writing is also different in the construction and length of paragraphs. Organizing your paper will require you to think carefully about the order of the topics and subtopics, the information you want to present, the appropriate use of citations, and the length of the paragraphs.

Generally speaking, paragraphs in professional writing are shorter than those in more narrative forms of writing. As you read through what you have written, look carefully for the subtle changes in the flow of your thoughts and break there for a new paragraph. Paragraphs can be as short as two to three sentences and are usually no longer than five to seven sentences. Of course there are exceptions to this but you should be very careful when your paragraphs begin to reach a half page. That is a clue that it may be time for a new paragraph.

Headings and Subheadings

Headings and subheadings help you organize your paper and provide you with a guide for the need for new paragraphs. APA provides for several levels of headings and subheadings to help you organize and present your paper. The following is a representation of each type of heading or subheading commonly used in college writing:

Level 1 Headings

Level 1 headings are bolded and centered and are reserved for the most important levels of information such as the title of the paper or main headings. All main words are capitalized.

Level 2 Headings

Level 2 headings are aligned with the left margin with all main words capitalized. This heading level is used for the majority of the text of your paper but helps the reader identify the key points and topics within your paper. The headings also help you as your organize and plan your writing and can easily be used as an outline.
Level 3 headings. Level 3 headings are indented ½ inch, bolded, but only use capitalization for the first word and any proper nouns. The heading is followed by a period with the text beginning immediately thereafter. This level of heading helps you further clarify important points in your writing and aids in transitions between topics. Level 3 headings should only be used when necessary and generally only appear in more lengthy papers. Check with your instructor if you have questions.
Title of the Assignment

Submitted by

Student’s Name

Course Number and Name

Professor’s name

Month, Day, Year of Submission
Sample Template for Written Papers
Title of the Assignment

Level 2 Heading Title

[begin text here] Change the heading title to match the content of what you are writing. Delete the [begin text here] and remove the highlighting. Then simply type your content information into the space below. Remember to watch for paragraph breaks. Add additional level 2 headings as needed for the topic and content of your assignment.

Level 3 heading title. [begin text here] When a level 3 heading is needed, type the heading title using the format provided. Then delete the [begin text here] and remove the highlighting. Remember to follow the formatting for this level heading (capitalization, bolding, use of a period, placement of the text). If level 3 headings are not required, delete the headings.
References

The references should be placed on a separate page. When you have finished writing the content of your paper, insert a page break by following these steps:

1. Place your cursor following the last sentence on your last page.
2. Click on the “Insert” tab at the top of the page.
3. Select “Page Break”.

Begin first reference at the top of the page immediately following the heading for References.

The heading title References is a Level 1 heading and is therefore **bolded** and centered.

The first line of a reference is placed at the left margin. Use ½ inch hanging indent for all other lines of reference text.

**Example:**

APA Help Sheet
APA Reference and Citation Style Help

Reference Style – For your Reference/Bibliography or for an article review

Periodical (Journal, Magazine)

One Author


Note: If the title of the article has a colon, follow this example.


Two or More Authors


Each author with last name first followed by first and middle initial with periods and one space between.

Comma with one space
Book or Other Non-Periodical


Chapter in a Book


Magazines


Newspapers


Electronic References

On-line versions - If you are referencing an on-line version of an actual article from a journal, magazine, or other publication that you found on the web, use this format:

ERIC Document


Citations within a Document

If you are citing a reference in your paper, you would use one of the following formatting styles:

One author. Use this format for citing a single-author source throughout your paper:

Jones (1999) stated that music has a strong impact on student achievement. If citing at the end of the sentence, use this format: Music has a strong impact on student achievement (Jones, 1999).

Two authors. If a cited source has two authors, you cite them both each and every time you use the source in the paper. Example: According to Brown and Jones (1999), the general education classroom teacher is often the first person to realize that a student needs special education services. If citing at the end of a sentence, use this format: The general education classroom teacher is often the first person to realize that a student needs special education services (Brown & Jones, 1999)

Three to five authors. If a source has three, four, or five authors, you will cite ALL of them the first time in the paper. Example: Smith, Jones, White, Green, and Brown (2010) stated
…… or (Smith, Jones, White, Green, & Brown, 2010). Then, for each and every text citation after the first one, you will use the et al. format. Example: Smith et al., (2010) stated or (Smith et al., 2010)

**Direct quotes and paraphrasing.** You MUST ALWAYS put a page number if you use a direct quote. Paraphrasing is preferred because it helps the reader know you understand and have synthesized the information because you can put it into your own words. Paraphrased citations (not direct quotes) do not include page numbers. Examples: According to Smith (2008), “pre-service teachers benefit highly from the hands-on activities available through practicum experiences” (p. 45). “Pre-service teachers benefit highly from the hands-on activities available through the practicum experience” (Smith, 2008, p. 45). Please note the location of the end punctuation mark for each citation. Direct quotes that exceed 40 words must be placed in an indented block format. These block quotes do not include beginning or ending quotation marks.

**Multiple citations of the same author within a paragraph.** When citing the same author multiple times within the same paragraph, use the full citation for the first instance (Brown, 2003) and then you may simply use (Brown). However, when you move to a new paragraph, you must then include the (Brown, 2003) citation again.

**These are the BASICS. You should all have a copy of the following publication:**

You can access information about APA style from www.apa.org and then select APA Style from the Quick Links on the left side of the homepage. This link will provide you with many examples and answers to frequently asked questions about APA citation and reference formatting.
DOI and URL Flowchart

Use the flowchart below to determine when to include DOIs, URLs, or database information for your reference citations. The notation “Ex: 1, 2…” refers to a few relevant examples in Chapter 7 of the 6th ed. of the APA Publication Manual (see also pp. 188–192).

Q: What do I need to know about DOIs and URL flowchart?
A: A DOI is a unique alphanumeric string that provides a persistent link to content online. Try to include a DOI for every reference. DOIs are generally easy to find from a search engine. Cross-referencing makes DOIs easy to find. Find a DOI lookup finds DOIs one at a time. If you cut and paste your reference list into the Simple Text Query Form, Cross-referencing will find all the available DOIs at once. For online material without DOIs, include URLs or database names/URLs as described in the flowchart.

Q: What do I need to know about DOIs and URL flowchart?
A: Try to get your readers to the material in a universally accessible, simple, and direct way. Many databases are subscription-based, and thus not accessible to everyone. Their content can also change over time. Although publisher web pages may also change (which is why DOIs are preferred), they are accessible to everyone and easy to find online.

If you are unsure how to cite a reference you found in a database, try finding a homepage URL first. Include database information only if your material is not easily located elsewhere (e.g., dissertations, monographs, or in-formally published papers, which may be available only through databases such as ERIC, JSTOR, or ProQuest Dissertations & Theses Database).

© 2009 American Psychological Association